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1 Welcome

Thanks for using MultiPing!  MultiPing is an application built for monitoring one or more TCP/IP targets,
while providing detailed historical information about the collection period.  MultiPing's time graphs
make a great way to quickly evaluate the uptime and quality of a connection to a target.

MultiPing has a number of valuable features for someone who wants to monitor their network
connectivity, including:

Monitors the performance of one or more targets  over time, allowing you to compare the
performance of these targets at any period of time.

Allows you to scroll forward or backwards in time  to look at performance at any period during the
collection session.

Saves lists of targets  to monitor for easy setup of future monitoring sessions.

The powerful "Timeline graphs " can be shown for any of your monitored targets, with any time-scale
you need to see the whole picture.

Any/all timeline graphs can be floated  anywhere on your screen, and configured to stay on top,
transparent, and a number of other options to make the graphs look just like you want them to.

Configurable ping interval so you configure MultiPing to capture data at the rate that makes sense for
your connection, and for the conditions you're looking for.

Packet loss is graphed and easily visible.

Will auto-start pinging on load, monitoring the destinations you were previously monitoring when you
last closed MultiPing, or alternatively it can load a setup of your choice.

Configurable  Good / Warning / Bad periods to easily identify which targets are in trouble.

Flexible, configurable alert system to monitor one or more targets based on the conditions you set. 
You can be notified by playing a sound, sending an email, changing the tray icon, or launching an
executable to allow you to customize your own alert events.  You can even do all of those within the
setup of one alert.

Proven multi-threaded engine for maximum performance over long periods.

Flexible workspaces , with the ability to save and reload at any time.

Can minimize to your system tray.

More ... (what feature list would be complete without the ubiquitous "more" feature?).
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2 Support / Help

Visit the MultiPing home page at http://www.multiping.com anytime!

We offer a number of online resources to ensure your success with MultiPing.  Licensed users get
priority, but we happily offer as much help as we can give to people evaluating MultiPing.

Check the online resources

Since the help file you are currently reading is relatively static (i.e.: there is no way for us to update this
without you downloading a new version), your first stop should be on our support site at http://
www.multiping.com/support.html. This site has links to online resources and other active content.

Get the latest version

If you're having problems with something that you think is a bug in MultiPing, you can visit our web site
to get the latest version.

Send us an email

You are always welcome to send an email to support@multiping.com.  We have a number of systems in
place to make sure we get your email, but again, please check our web site before sending us an email
since we may have resources there that answer your question (ie: FAQs, knowledge base, etc.).

http://www.multiping.com
http://www.multiping.com/support.html
http://www.multiping.com/support.html
http://www.multiping.com/files.html
mailto:support@multiping.com
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3 Licensing

MultiPing is developed under the trialware (or shareware) concept. You're probably familiar with this.  You
can try out the software for a limited time (30 days) after which you need to pay for it.

MultiPing is completely full-featured for the first 30 days of trial mode, after which it disables one or more
features (including Alerts, and possibly other features).

A license key will immediately convert the trial version of MultiPing to a fully licensed version.  All
distribution is done electronically for fast and easy access.  

The easiest way to order is by visiting our web site at http://www.multiping.com/order.html.  This site has
all pricing and ordering instructions.  Volume discounts are available.

If you have specific questions, or are unable to reach our web site for any reason, please feel free to
contact us at sales@multiping.com.

Thanks for trying MultiPing!  We appreciate getting the opportunity to serve your networking needs!

http://www.multiping.com/order.html
mailto:sales@multiping.com
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4 Getting Started

4.1 Things to do with MultiPing

MultiPing has a number of things it can help you with.  Here is a list of a few of them:

Monitor key servers or routers.

Want to see the status of any of your important servers at a glance?  Need to know if they're
responding, or responding *quickly*?  MultiPing can help you with this.

Pick the best server.
If you're a gamer or stock trader, latency is important for your ability to make decisions.  Set up a list
of possible servers that you *might* use, and then examine this list when you need to connect to or
change servers.  MultiPing can sort your list of servers by latency, name, packet loss, and more.

See why performance is bad.

Sometimes you may be getting poor performance from a server, and you don't know if it's a network
problem or a server problem.  Use MultiPing to continuously monitor one or more servers, and then
look at the ping performance to that server when you start to experience problems.  Is it a latency
problem, a packet loss problem, or some other problem?  MultiPing can help you isolate that problem,
and it captures history so you can look at the past few hours for problems that may have occurred
during that time period.

Get alerted when a server goes down.
MultiPing can be configured to alert when a server's latency or packet loss doesn't fall within
acceptable parameters.  In the event of a failure, MultiPing can play a sound, change the tray icon,
launch an executable, or email you.

Keep an eye on a server.
MultiPing lets you float a graph on top of everything, transparent if you like, so you have constant
access to status.

Keep your connection alive.
Sometimes you need regular network activity to keep your connection alive.  MultiPing can do that for
you, and gives you the bonus of collecting latency and packet loss data while doing so.

Monitor your VoIP server(s).
If you normally use a VoIP phone, you might sometimes hear blips, feedback and garbled sounds.  If
you're not sure if it's your phone or the other party, fire up MultiPing and have it monitor your VoIP
server.  A quick glance can tell you if there's a network problem or not.

Get alerted when the IP address of your website or server (or home) changes
(using Dynamic DNS)
New with MultiPing version 3 is the ability to be notified if a target's address changes (based on the
lookup address changes for a specific DNS name).  MultiPing can automatically notice the change,
update the address it's monitoring, and then notify you of the change (via email or similar).

More!
There are definitely a lot of other uses for MultiPing.  If you're using MultiPing in ways we've not talked
about here (but think should be included), please drop us an email!

mailto:info@nessoft.com
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4.2 Pinging a Target

When you first start MultiPing, it's a "blank canvas" of targets.  You probably have a target in mind that
you want to ping.  Just type that target into the "Enter New Target:" field and hit Enter (or click the "Add
to ping list" button).  This will (with the default settings) automatically look up the IP address for the
name you entered, start pinging that target, and also automatically show a timeline graph for that target.

As you add new targets, the addresses you entered are also added to the history list for easy access in
the future.  If a target is already in history, double-clicking it will start pinging that target.  Right-clicking a
target in history will bring up a menu to allow you to delete from history, or to alphabetically sort the
history list.  This only manipulates the history list, not the current list of pinging targets.

Renaming a target

Lots of people enter targets in MultiPing as IP addresses.  Often these IP addressed don't resolve to a
meaningful name.  If that's the case, you have a couple of options for changing the name to make more
sense.

"Alias" the IP address by entering the IP address followed by a space, then the alias you want to use.
 Example:

192.168.10.133 My Server Name

In this case, "My Server Name" will be used throughout MultiPing.

You can rename a target at any time just by right-clicking on the target in the upper graph and
selecting "Rename selected target".  This will let you enter an "override" name.
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5 Operation

5.1 Targets Graph

The "Targets" graph is a list of all the targets that are currently being pinged.  This can be sorted by
clicking the column header that you want to sort by, and can be manipulated in a variety of ways by
right-clicking on the grid.

There are a number of columns that can be displayed on the Targets Grid.  Some of these are optionally
displayed, and they can be shown / hidden by right-clicking on the grid and using the "Customize View"
menu option.  The colors displayed and indicators are customizable .

Note: all statistic columns use the "Samples to include" setting to know how many samples to examine.

Status Column

The Status column is always displayed as the left-most column in the grid.  This is used to show if an
alert is applied to this target, and also if there is a time-graph visible in the main screen.

When a time graph is visible for a target, the status column has a thick black bar.  Double-clicking on
that will turn the time graph on and off.

When an alert is associated with a target, a bracketed A will appear.

When an alert is "alerting" for a target, an exclamation point will appear on that target.  

Floating your mouse over the exclamation point will show more details about that alert.

The exclamation point only appears if you're looking at the current time period.  If you go back and look

24
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at history, the alert "exclamation point" will not appear.

Err Column

The "Err" Column shows the number of lost packets.  This is an exact numeric count, is not an error
code, but just an error count.

PL%

The PL% column is the percentage of lost packets.  This is the Err (above) number, divided by the
number of samples collected.  This normally matches the "Samples to include" number after enough
samples have been collected.

IP

This is the IP Address for this target.  Every target has an IP Address, and each IP Address can only
exists in the list once.  

DNSName

This is the best name that MultiPing can determine for this target.  If you entered the target in name
form, rather than IP Address form, then that name will be displayed.  If you entered an IP Address, then
this is the reverse resolved name.  If you entered the target in the form: "192.168.10.23 My Server
Name", then "My Server Name" will be displayed here.  You can use this mechanism to use your own
names for the targets.

Avg

This is the true average latency for this target.  Total the latencies, divide by the count and you'll have
what is displayed here.  A lost packet does not contribute to this average, however.

Min

The lowest latency in the period.

Max

The highest latency in the period.

Cur

The most recent sample collected.  This might be "ERR" if the most recent sample was a lost packet.
 If you're looking at data in the past, this is the most recent sample in the period under inspection.

Graph

This is a great column of the grid.  This shows a Min/Max line (unless it's hidden), a blue current
"X" (most current sample), and a red "average" line (the vertical line).  Packet loss is also displayed
here as a light red bar, which gets longer as the packet loss increases.  

5.2 Time Graphs

The timeline (history) graphing feature of MultiPing is one of the more powerful and unique aspects of the
program.

Timeline graphs allow you to see performance over time, and to compare performance of multiple targets
for a period, including latency and packet loss.

By default, MultiPing will automatically add a time graph for every manually entered target.  If you load
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from a file, these targets are not added automatically (as there could be a significant number of targets
that would interfere with the user interface).  If you want to show or hide any specific graph, you can do
so by double-clicking the target in the upper graph, or by right-clicking the target in either the upper
graph, or the floating graph (if it's already visible and you want to hide it).

Focusing and zooming

Once pinging, each sample will be recorded on the timeline graph.  The amount of data displayed on the
graph can be changed by right-clicking on the timeline graph and then selecting the amount of time you
want displayed.  This scale affects ALL timeline graphs that are docked in MultiPing, and is saved when
you shut down Ping Plotter.  Any floating graphs use their own independent time period.

If there is more data collected than you can show on the timeline graph with your selected scale, click
on the graph and while holding down your mouse button, then drag the graph.  This will allow you to
move back in history and examine the samples.  

If you find a time period that looks "interesting", you can double click on the timeline graph at that point.
 The upper graph (the trace graph) will move to that time period (this only applies to the timegraphs that
are docked in the MultiPing window - Floating graphs do not change the focus).  This allows you to
troubleshoot where the connection problem may have occurred.  Keep in mind that the upper graph
always focuses in on the number of samples in "Samples to include".  If you have that set to ALL, then
the upper graph can't zoom in on any piece of the graph.

It may be that you see a problem period in the 48 hour graph.  Double-click on that period, and the upper
graph will focus on that period.  You can then change your timeline graph scale, and the lower graphs
will try to stay focused on the time period you selected.  This makes it easy to see details about a
specific period.

When you're done zooming the graph, right-click on it and select "Reset focus to current".  This will
return both graphs (the timeline and the upper ping graph) to the current time.

Because MultiPing takes so little CPU time when running, you can set it up to ping continuously and
then occasionally look back at the collected data for interesting periods.

Shortcut keys and other tips

You can also use the keyboard to scroll.  To scroll with the keyboard, select the timeline graph and use
one of the following keys:

ALT-HOME scroll to the beginning of the collected data

ALT-END scroll to the end of the collected data

ALT-LEFT scroll back in time (about 5% of the graph width)

ALT-RIGHT scroll forward in time

ALT-PGUP scroll back in time (about ½ of the graph width)

ALT-PGDN scroll forward in time

If you're using a mouse with a scroll wheel, select a time graph and then use the scroll wheel to move
forward and backwards in time.  Holding the CTRL key while scrolling with the mouse wheel will change
the time scale (this can also be depressing the mouse wheel while scrolling).
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5.2.1 Controlling Time Graph Visibility

Time graphs are displayed in a couple of ways.

Floating time graphs

Floating Time graphs are manually turned on and off - there is no way for MultiPing to automatically
create floating graphs for you.  See our Floating Time Graphs  section for more details.

Time graphs docked in the main window

Time graphs that are docked in the main window have shared settings, so they scroll and resize
together.  These graphs can be set to automatically appear, or to only appear on command.

Normally, when you manually enter a new target name, you'll want the time graph to automatically
appear.  This behavior is controlled in the View menu with the "Auto-show added graphs" option.  This
only creates new time graphs for targets that are manually entered, not ones that are loaded from file.  

Often, when loading from file, you'll have a number of targets and displaying all of them doesn't make
sense.  This is why the "Auto-show added graphs" doesn't apply to loading from file.  If you want all
graphs shown after loading a set of targets from file, use the View menu command "Show all timeline
graphs" (and the counterpart command "Hide all timeline graphs").

Manually showing a graph

You can hide and/or show a time graph at any time by double-clicking on the target in the upper graph,
or right-clicking the target and selecting the "Show this timeline graph" menu option.

Sorting the time graphs

The upper graph in MultiPing is easily sortable - just by clicking the appropriate column header.  Time
graphs, though, are not sorted that same way.  If you want to sort your time graphs in a particular
order, just change the sort order of the upper graph, then right-click on a time graph and select "Sort to
match target list."

Resizing time graphs

Once you get a few time graphs shown, you may wish you could resize (make them taller or shorter)
the time graphs but are unable to because of the existence of the scrollbar on the time graph area.

To resize all of the time graphs, scroll to the last time graph (the scroll bar should be at the bottom of
its range).  Now, float your mouse cursor between the lowest graph and the one above it - you should
get a resize pointer and you can then size the graphs at your pleasure.  All time graph will resize to
match.  

15
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5.2.2 Pixel Averaging

The height of the red line on a Time Graph indicates the percentage of packet loss in the time period
being represented by the pixel.  Keep in mind that based on the number of samples you collect and the
scale of the lower graph you're showing, all timeouts may show up as 100%, or there may be multiple
samples in any pixel.

If you're doing a trace every 10 seconds, and you're showing 10 minutes of samples, this is only 60
samples.  Any one sample is going to take multiple pixels to display.  On the other hand, if you're doing
that same thing and showing 48 hours, that's 17280 samples and some averaging of samples needs to
be done to display all the data.  This is where the packet loss percentage really makes sense in the
lower graph.  In this case, you're probably going to have about 35 samples being averaged in any one
pixel width, so the line height of the latency is going to be an average number, and the packet loss is
going to be a percentage based on how many failed and how many succeeded.  If there were no
successful samples in a pixel width, then there will be no black line showing the latency, but instead a
full-height red line to show 100% packet loss.

Additional information can be found in our knowledge base.

5.3 Floating Time Graphs

MultiPing allows you to "float" a time graph and have it visible independent from the main MultiPing
program.  This lets you keep a graph visible while doing other things, without having the MultiPing user
interface taking any screen real estate.

To create a floating time graph, right-click on the target you'd like to "float" (either in the upper graph area
or on the lower docked time-graph if that graph is visible).  The popup menu will have an option for "Float
Time graph" (or Float this Timeline Graph if right-clicking on the upper graph).  Selecting this option will
create a floating time graph. 

MultiPing floating graphs are distinct, independent graphs, and are moved and manipulated individually. 
You can right-click on any graph to change the settings for that graph.  Listed here are the settings that
can be changed from the right-click menu of a floating graph:

Visible time period.  The time period that this graph is showing can be selected.  If the predefined list
of times isn't right for you, this list is editable by modifying the .INI file.  Check our web site for
instructions on this.  If you want to apply the time period for the currently selected graph to all graphs,
use the "View Options" menu and then "set as default".

Close/Hide this graph.  As you might suspect, this just closes the floating window.  MultiPing will
continue to ping this target even though the graph is closed.

Change the target this graph is looking at.  The current target is listed in the menu, and expanding that
menu entry shows all targets currently being monitored my MultiPing.  Entries that currently have no
floating graph will be bold.  The currently selected target has a checkmark beside it.  If you want to
have multiple floating graphs (with different time periods) for the same target, this is the only way to do
that.

Create Comment.  You can annotate the data you're collecting to document events that may affect
your network performance.  The comment will be created at the point in the graph you right-clicked.

View Options.  This controls how the graph is being displayed, and also lets you apply these settings
as the default for future floating graphs.  We discuss the View Options in more detail here .

Reset Focus to Current.  If you've changed the period of time you're looking at, then you may want to
re-focus on the current period.  This will show newly collected data as it is collected, rather than using
a fixed time period in the past, and this option only exists if the graph is focused on a non-current

16
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period.

Floating graphs will "snap" to any side of the screen, and also to any other floating graph.

5.3.1 Floating Graph View Options

Floating time graphs  have a number of view options that can be applied to them to match your needs.
 Access these options by right-clicking on a floating graph and selecting "View Options".

Note that this popup dialog can be moved by dragging it (left-click/drag).  It closes when you click an
area of another program outside of this dialog (i.e.: the task bar, start menu, another area of MultiPing,
etc.).

Show/Hide Title Bar.  When the title bar is visible, it is a small Windows "toolbar" size of title bar. 
Hitting the "X" on this title bar will hide this graph.  When the title bar is *not* visible, then you can
move the floating graph by grabbing the upper or left-most region of the graph (shown here). 

If you grab and drag elsewhere in this graph, then you'll change the time period that you're examining
rather than moving the graph.

Show Time "Tics".  This is the time labels on the bottom of the graph.

Show Address / Time Period.  This is the upper edge of the graph that shows the target and current
time period.  We suggest that you leave this *on* - otherwise you don't know which target you're
looking at, or how much time you're examining.

Show Latency Scale.  This is on the left side of the graph that shows the range of latencies that is
being displayed.  This is another good option to leave *on*.

Show Packet Loss Scale.  When more than one sample is displayed in every pixel, packet loss might
be displayed as a percentage rather than just a red "all-or-nothing" bar.  This is occasionally useful,
but you may want to turn this *off* to increase the amount of data displayed in any period.

Stay on top of everything.  If this is checked, then you'll always be able to see this graph.  This is a
popular option to leave on.

Transparency.  You might want to be able to see what's *behind* the floating graph.  Use
Transparency for this.  Note that this is only supported on operating systems that support alpha
blending (i.e.: Windows 2000, XP, 2003).

Set as Defaults.  Once you have the options set the way you like, use this button to set the default
values that will be used by all new floating graphs.  You'll also be prompted here asking if you want to
apply these settings to the other graph instances that are currently visible.  The time period from the
currently selected graph also gets set as the default time value, and is also applied across the other
graphs if you select it to do so.

5.4 Workspaces and Data

MultiPing can save its current workspace environment, including all targets, into a file so you can easily
reproduce the environment.  These files store:

15
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All targets being currently pinged.

The list of TimeLine graphs visible in the main screen

All floating time graphs, their locations, sizes, scales and other settings.

The sort order (if you're sorting)

Collected data (if that option is enabled).

Be default, when MultiPing is closed, it will automatically save its configuration to one of these files
named "DefaultWorkspace.mws" in the MultiPing install directory.  When MultiPing is reloaded, it will
automatically reload that same file.

You can also manually load a workspace at any time, and save at any time.  These files are in text
format, in case it needs to be manually manipulated for any reason.

An option that is new to MultiPing version 2 is the ability to save collected data with the workspace.

Using a non-default workspace.

You may have different monitoring scenarios that you use in MultiPing at different times (or maybe at the
same time!).  When you load a workspace (that isn't the default workspace), the title bar on MultiPing
will change to show the workspace name.  This allows you to have multiple sessions of MultiPing
running doing different things.

Saving collected data with a workspace

New to MultiPing version 2 is the ability to save collected data with your workspace.  The collected data
is saved in a directory matching the name of your workspace file.  When reloading the workspace, the
collected data will be reloaded as well.

If, for some reason, the collected data is unavailable, the workspace will still load, but the collected data
won't.

5.5 Loading targets from a file

MultiPing supports loading targets from several file types - one general format, and one MultiPing specific
type.

Loading generic target lists (*.lst, *.mpl)

MultiPing can load any list of targets from a file - one target per line.  Each line in the file is one target,
and is parsed exactly as though the target was entered in the "Enter New Target" edit box.  Invalid
targets in the file will cause an error to be displayed, and MultiPing then moves on to the next line.

Saving generic target lists (*.lst, *.mpl)

At any point, you can save the list of targets that MultiPing is pinging into a file that has one target per
line.  This can be done from the File menu with the "Save Target List..." menu entry.  The default file
extension is .mpl (MultiPing List), but this extension isn't special in any way.

MultiPing Workspace (*.mws)

MultiPing workspace files are created by MultiPing and store the "state" of MultiPing.  These can then
be reloaded later to resume a monitoring session.  We have a help section on workspaces  which
outlines their use.

16
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5.6 IPv6 and IPv4

Starting with Version 3 of MultiPing, you can monitor both IPv4 and IPv6 targets.

Picking the right type from a name

MultiPing will automatically pick the right address type when you enter a name. It uses the Windows-
standard name lookup utility, so it will pick an IPv6 address over IPv4 based on how Windows works. 
Some targets (a growing number off them, www.google.com is one example) will let you use their
services either way.

If you know specifically which protocol you want to use, you can prefix the name with the IP type, like
this:

ipv4:www.google.com

or

ipv6:www.google.com

If your computer supports that IP type, then MultiPing will use it.  If not, you'll get an error.

Changing the lookup priority

If you normally want to use a different method than what you have Windows using (maybe, for example,
you have Windows always use IPv4 even though it supports IPv6, and you want to ping IPv6 if you can),
MultiPing will also let you prioritize the lookup type.  Go to Edit->Options, Packet  to make this
change.

5.7 Dynamic DNS, tracking and notifying

Dynamic DNS is a popular way of running servers without a static IP address. If you'd like to monitor
your server remotely and you're using Dynamic DNS to do this, MultiPing can now handle that job.

MultiPing can track dynamic DNS changes (it won't initiate them).

Setting it up

Most targets don't need to be tracked, so you'll need to manually configure tracking. This is done through
the alert system.

First, set up the alert (Edit -> Alert Setup...) - something like this:

25
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Pick the "Method" as IP Address Change, and then edit the frequency you'd like to have a target
checked.

From here, you can also set up Alert Events, so you can be notified of any changes (through a tray icon
popup, send an email, or any of the other alert methods supported by MultiPing).

Hit "OK" to save your alert.

Associate the alert to the target you want to watch

You're half done (well, maybe 3/4, but the last 1/4 is super-important).

Now, add your target to MultiPing (or find it in the list if you're already pinging it), and right-click the
target. Select "Watch this target (alerts)...".  Move your new alert from Available to Selected, then close
that.

That's it!

What happens when an IP changes

For any target that is being monitored for changes, if/when it does change, a note will be added to the
time graph in MultiPing mentioning the original and new IP address.

If you have any events set up, these will be called.

The IP address for the target will change - even if you scroll back before the point of the change.  You
can look at the comments to see the changes.

Notes

Only targets that are being monitored by this type of alert will be checked for IP address changes.
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Only targets that were entered with a name will be checked (if you entered an IP address, there's not
much chance the IP will change from that, right?).

 

5.8 Running from a USB drive

MultiPing can be run from a removable drive (like a USB key) without having to be installed, or modifying
anything on the "host" machine where you're running MultiPing.  This is great if you administer a number
of PCs and want to be able to run MultiPing without having to install it, and/or enter a license key.

There are several differences in operation when MultiPing is running from a USB drive in special USB
mode.

The license key is stored on the USB drive, not in the system registry.  This means you don't have to
enter the license key on each machine you're running on.

All MultiPing settings are written to the .ini file on the USB key (in .exe directory - so make sure it's
writable!).

MultiPing does not check in the user's profile for override settings.

To run MultiPing in this special mode, follow these steps:

1. Install MultiPing normally on your computer's hard drive (not the USB drive).

2. Copy the entire directory where MultiPing is installed to your USB drive.  This should include all
subdirectories that may exist.  You can put this in any directory on the USB drive, but we'll assume
this is in f:\MultiPing for now.  The executable to launch MultiPing would then be f:\MultiPing
\multiping.exe

3. Uninstall MultiPing from your computer's hard drive.

4. Create an empty file named "license.dat" into the directory where multiping.exe exists on the USB
drive (in our example, this is f:\MultiPing).

5. Launch MultiPing from the USB drive.  When prompted, enter your license key.  MultiPing will put
your license information into the license.dat file.

6. Create an Autorun.inf (outside this scope of this topic, but email us if you need help) or hook up the f:
\MultiPing\multiping.exe file to your USB drive's menu system.
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6 Options

This section is a reference of the different options available in the options screen.  The option screen is
reachable through the Edit -> Options... menu item.

Applying (and identifying) Pending Changes

First, any changes made to these settings do not take affect until you either hit the "Apply" or "OK"
button.  The Apply button will become enabled when there are any changes pending to be applied.

The topics in the tree view with the * marks (asterisk) are the ones that have changed.  Hitting the Apply
key will write these changes to PingPlotter and put them into affect.  Hitting the "OK" button will do the
same, but will also close the options dialog.

Hitting cancel will back out the changes that have not been applied.

You can make changes to multiple areas before applying them.
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6.1 General

The "General" options section is ... well .. a collection of miscellaneous options.

Auto-start pinging when new target added

This option allows you to add a number of targets to the target list without immediately starting to ping
each one as you add them.  The default behavior is to start the ping cycle immediately on adding or
loading a target.  If this is off, you'll need to manually hit the "Start" button.  The "Start" button will flash
if you add a target with this option turned off - to remind you that no pinging is happening.

Show icon in tool tray

A handy option for long term monitoring is the ability to move MultiPing to the tool tray.  When
minimized, MultiPing will only show up in the tool tray.  When not minimized, it will also be shown in
the task bar.

Action for close button

If you run MultiPing all the time, you might not want to close MultiPing when the "X" button is hit.  If
that's the case, you have several additional options:

Close MultiPing: Immediately close MultiPing without prompting.

Minimize MultiPing: Instead of closing, just minimize to the taskbar or tool tray, depending on your
preferences.

Prompt to close: When this is set, instead of immediately closing, you'll be prompted to close. Hit
"Cancel" if you don't want to close.

Auto-save default workspace

If you normally ping the same targets, MultiPing will remember them and automatically save and reload
this list when you start / stop MultiPing.  If you'd prefer to add your own targets (manually, or by 
loading another list or workspace ), then turn this option off.

Save collected data with workspace

It can be useful to save collected data with the list of targets you were pinging.  This will allow you to

17
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resume a ping session without losing any of your collected data.  For more details about workspaces, 
see that section .

Auto-save workspace on a timer

This option is useful when you're saving collected data with your workspaces.  If this is off and your
computer crashes or MultiPing is closed abnormally, then your collected data might not be saved. 
Enabling this option will make sure you don't lose all your data.

Setting up an auto-save interval makes sure you don't lose more data than you're comfortable with. 
There is a list of times that can be picked by hitting the up or down arrows, or you can enter any time
you like (e.g., 22 minutes or 75 seconds).

6.2 Display

The "Display" settings control the general display format of MultiPing's graphs, including scaling,
coloring, and other general values.

Show legend

The legend is shown above the graphs on MultiPing to indicate the range of latencies used for
each color band.  This legend is automatically hidden if there isn't enough space for it.  Turn 
off this option to never show the legend.

Warning and Critical speed limits 

Changing these values sets the Green / Yellow / Red threshold for the graphs.  This is dependant on
your expected performance.  For a modem, 200 ms might be quite good, while for a T1, it could be
considered bad.

Draw X on graph for current sample 

When examining current data, sometimes its handy to graph the most recent sample collected.  Turn
this on to see that.

Draw line to show Min/Max Range 

When showing just a few samples, this can be really handy to see the range of latencies.  As you
increase your window, though, a single bad sample can make this line stretch the scale of the graph.

16
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Graph Scale 

Normally, setting the graph scale to automatic works pretty well.  Sometimes, you might get a few
samples *way* out of range, though, that stretches the scale.  This is especially likely as you increase
the value for samples to include.  

Packet Loss 

Most often, graphing the packet loss is a handy, easy way to see lost samples.  30% seems to work
great for highlighting just the right of loss in most cases, but you're certainly going to run into cases
where you want to change this to something lower (as low as 1) or higher (any number is valid - even
over 100).

6.3 Packet

Name Lookups (IPv4 and IPv6)

By default, MultiPing will use the default Windows system to do name lookups, and to priorize IPv4
and IPv6 names. That might not always be what you want, though, so MultiPing lets you manually
override that.  For either of the "Prefer" methods (Prefer IPv6 and Prefer IPv4), if both types are
available, the preferred one will be picked. You can also stick with just IPv4 or IPv6 lookups with the
appropriate setting.

There's one additional way to get exactly what you want - if, when adding a target in MultiPing, you
precede with name with IPv4: or IPv6:, then that type will be forced, no matter what this setting says.

Ping Timeout

When MultiPing sends out a packet, it waits a certain amount of time for a response.  The longer it
waits, the more resources it needs to use (to keep sockets open), but the more likely that it will get a
response.  The default number is 3 seconds (3000ms), which is enough time for just about any target
to respond.  If you ping a lot of targets, you can lower this a bit (1500 is still pretty safe).  If you're on a
really slow network, you might want to increase this to 9999 or higher.

Time interval between hop traces 

MultiPing sends out packets without waiting for other packets to return.  This doesn't mean, however,
that it sends out all packets at once (you don't want to do this, or it might overwhelm your bandwidth). 
This is in ms (or 1/1000s of a second).

Packet Size 

The Packet Size can make a considerable difference in latency performance.  Normally, you want to
use a relatively small number here.  The default is 56 bytes, but in some cases you might need to
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lower this. Large packets should be used with great care.  A 1500 byte packet means MultiPing may
be sending out 30-50 K per second worth of data, which can cause its own problems (and makes
measuring latency more challenging).

Maximum samples held in memory

Long-term monitoring sessions might start to fill up memory, making things run slower.  If you want to
purge off old samples when memory starts to get full, set this.  This defaults to 200000, which will take
(very) roughly a megabyte of memory per target.

6.4 Version

Version checking options control how often MultiPing checks to see if there is a new version available. 
This requires an internet connection.  If you're using a proxy server, then entering your proxy server
information here will allow MultiPing to check for a newer version of itself.

Please keep in mind that this does not affect the way Ping requests are sent at all.  Proxy servers do not
support Ping requests, so you'll need to open up your firewall to allow outbound ICMP echo requests and
returning ICMP echo replies.

6.5 Email

Email options are used for sending email alert notifications.  When sending an alert via email, MultiPing
needs to know some information before it can dispatch an email.  If you're not using email alerts, there is
no need to fill in this information.
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Return Address

All outgoing emails will have a return address specified, and this is the address that is used.  Please
make sure you specify a valid address here since this is where all the bounce messages will come
from.  Some ISP SMTP servers only allow emails sent out with a "from" address of their domain as
well, so if you're having problems getting the SMTP server to work, make sure you're using a valid
return address.

Include "alert" samples in text message

If this option is checked, any outgoing alert emails will include text showing the samples that failed the
alert.  As each alert email goes out, the past history is marked as being sent already so that you won't
get duplicate data in reoccurring emails.

SMTP Server

The SMTP server is the server that your outgoing mails will go through.  This may have been given to
you by your ISP or your mail administrator.  

Server Port

The default port for most SMTP servers is 25.  If you connect to your SMTP server via a different port,
then enter that port here.  Leaving this blank will use port 25.

SMTP Authentication

Some SMTP servers require a username and password to be able to deliver mail.  If this is the case
with your server, turn on the "Use SMTP Authentication" checkbox, and then enter your username and
password.  Fair warning: the password is saved in your MultiPing.ini file using a basic XOR encryption
scheme - this will keep your password hidden, but this encryption method is relatively simple to
"crack" if someone really wants to figure it out.
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7 Alerts

7.1 Creating / Configuring Alerts

What is an alert?

Alerts basically monitor the conditions of a specific IP address, and then do something when those
conditions exceed a specific range. The things you can do with an alert are:

Send an email

Play a sound or .WAV file

Log to a text file

Change the tray icon / show a message

Launch an executable

For example, let's say you need to know when a destination you're monitoring stops responding. You
can attach an alert within MultiPing to that IP address so that you receive an email alert if the last 10 of
10 sample requests are lost. 

Another possible alert condition to check for is if the average for the last 10 samples is > 500 (or any
other number). You can send an email alert, maybe play a .WAV file (if you're usually within hearing
distance) or both. Also, if you're trying to show your ISP there's a problem, you might log the data to a
file so you have records of every time it happened over a time period.

One user had hardware problems with his cable modem.  He set up an alert that launched an executable
 that then communicated with a device attached to his computer to reboot the cable modem when

alert conditions were met.  There are a whole variety of things you can do with alerts and events.

Alert setup can at first seem confusing, but it involves these four steps 

1. Setting the Alert Name

2. Setting up the Condition that will trigger the alert.

3. Specifying the Event(s), or what you want MultiPing to do when your alert(s)s are triggered.

4. Tying the alert to a target that you're monitoring.

What is an event?

Events go hand in hand with alerts.  Any number of events can be created with an alert - so that when
some conditions occur, something happens.  The "Alert" part specifies the conditions and serves as a
container for the events.  The "Events" specify what action(s) will happen.  You can have any number of
events tied to an alert, and any number of alerts tied to a host.  Note: You must have an alert tied to an
IP address before it will work.  Keep reading for more details.
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Alert Dialog / Settings

Alerts are defined in the Alert Setup screen under the Edit/Alert Setup menu. Once there, you'll see an
image similar to the one above. (Note: if you haven't setup an alert before, you won't see any alerts listed
in the list area on the far left of the screen shot). This screen is pretty busy, but also pretty self-
explanatory. From the screen capture above, you can see that we have (labeled on the image with
corresponding numbers in this list):

1. The Alert Name. In this example we're using "Destination is Over 100ms".  

2. The list of alerts you currently have defined. You can see from the image that we have two defined.

3. The Conditions for the alert. In other words, what has to happen for this alert to fire.

4. The Show Targets button that allows us to see how many targets/hops this alert is assigned to, as
well as the IP address or DNS name for that hop or hops.  If this alert is set to watch 0 targets, then
the alert will not fire!  We discuss this in more detail later in this topic.

5. The Notification/Trigger Events for this alert. An unlimited number of events can be tied to an alert, but
most likely you won't use more than four or five. Please see the Event Notifications/Trigger
Notifications section  for all of the trigger notifications available.

6. Each Event/Trigger Notification will allow you to "do something", based on the overall type of alert
you're defining. For example, with a Tray Icon Alert  you define the message the pop-up will
contain, a Send an Email Alert  needs to know where to send the email and with what frequency to
send, a Play a Sound Alert  needs to know what to play, etc. You enter that information here under
the trigger event.
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7. (These options are only for the Send an Email  Event type).  The Edit Body button will take you into
the email Alert Email Body Editor, where you can fine tune the alert message body for optimal viewing
on a cellphone, pager or other type of handheld device. By clicking this button, you can verify that your
email settings are correct , and what your alert email will look like.

8. To define a new alert you click on the New button. To delete an alert, highlight that alert in the list
above these buttons and click on the Delete button. When you're done defining the alert click the OK
button. Cancel exits this screen without saving anything.

So referring to the image above, you can see we have an an alert with a Condition defined where when
the last 10 samples are greater than 100ms, we want MultiPing to email us. We've called this alert
"Destination is Over 100ms ". If you were watching for a timeout, you'd enter 9999 instead of 100. Do
note that 9999 is not a magic number. A lost packet is always greater than any number entered, so you
can use 1000, or 20000 here and a dropped packet will exceed either of those numbers.

Setting up an alert.

It's usually best to start out with an alert and event that's easy to verify - like playing a sound, or
changing the tray icon.  So, let's set up the alert to play a sound when packet loss goes about 40%. 
Packet loss is a big bad thing, and in many cases is more important than latency.  We run a similar
alert at Nessoft HQ pretty much continuously.

Run MultiPing and go to the "Edit/Alert Setup" menu. If you've never set up an alert, you won't have
any listed here. 

Hit the "New" button (near the bottom left). 

Enter a name for the alert (We’re using "Server is Down") in the "Alert Name" section. 

In traces to examine, use "10".  Set it to alert when 4 or more samples are over 9999.  (Note: 9999 is
not a magic number.  A lost packet is always greater than any number entered, so you can use 1000,
or 20000 here and a dropped packet will exceed either of those numbers).  That setting will alert when
40% packet loss is achieved.  The 40% comes from saying to alert if 4 of the last 10 samples were
dropped.  You might want to do 40 of 100, or 2 of 5 - it depends on the period of time you want it to
look at.  You probably *don't* want to notify if only one sample is lost, but maybe 2 in a row (which
would be examining 2, and alerting if 2 or more traces over 9999).  Lots of things you can do here.

Alerting on packet loss.

A common condition to want to alert on is packet loss.  The fields you need to manipulate are in the
Alert setup screen is the "Alert conditions" portion.

Example: Let's say you want to notify when packet loss equals or exceeds 40%.

To do this, set "Samples to Examine" to 10, and Alert when "4" or more samples are over 9999ms. A
lost packet always exceeds any number you enter in the threshold area, so if you want to consider only
explicitly lost packets, set this to 9999. If you want to consider any really high latency packets as well,
set this to something lower (maybe 1000 or 1500).

This only examines the last 10 packets, but let's say you want to examine a higher period - and notify on
a lower packet loss percentage.

Set Samples to examine to 10000 (or some other high number). Alert when "500" or more samples are
over 2500ms. This will alert when you hit 5% packet loss over a period of a few hours (depending on what
trace interval you use).
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Picking an event.

Next, select what you want to happen when the alert fires. We're going to "Play a sound" (This is in the
Event 1 area).  Notice that as soon as you change the "Event type" to "Play a sound", that "Event 2" will
appear, with "(.. no additional notification ..)".  You can have as many events as you like - and to delete
an event, just change its type to "(.. no additional notification ..)".

As soon as you pick an event type, a set of options relating to that event type will come up.  The "Notify"
dropdown is described in more detail elsewhere.  For more details on how to set up a sound event, click
here .  

For this example, use "Notify: each time alert conditions are met (repeating)" and then hit the folder icon
beside the "Play Sound:" edit field.  Browse to an appropriate sound file (.wav or otherwise) on your
computer to fill this box.

Using this event, each time a sample is sent out and the alert conditions are met, the selected sound
will play.

Tying an alert to an IP.

Once you've got your alert set up, you need to tell it which IPs to "watch" for those conditions. To do
this, trace to a destination just like you normally would. Once the path has listed, pick the router/
destination from the list you want to monitor - and right-click on the hop number. From the popup, select
"Watch this host (Alerts)...".  If you want to monitor a destination that isn't responding for some reason,
just right-click on the lower time-graph for that host, and you'll have a similar popup menu.  

You'll get a dialog that shows the DNS name (if there is one) and the IP address you selected - and then
a list of available and selected alerts. Move the alerts you want applied to this IP address into the
"Selected" list - and then close the dialog. Monitoring will start immediately.

When a hop is being monitored for an alert, the hop number will have brackets
around it (i.e.: [10]). You can stop monitoring by right clicking on the hop
number and selecting "Watch this host (Alerts)..." and then removing any alerts
from the selected list.

You can stop monitoring by right-clicking on the hop number, selecting "Watch
this host (Alerts)...", and then removing any alerts from the selected list.

Any time an alert has fired, MultiPing will let you know by putting a red exclamation
point (!) next to a hop that has had an alert fire. This is particularly handy when you
have an alert that doesn't give you visual or audio cues normally when it fires, like a
Send an Email Alert. Now you can see it on the main MultiPing screen before the alert
email gets to your inbox.

Editing the body of an email
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The Alert Email Body editor allows you to fine tune the body of the alert email to whatever makes sense
for your particular receiving device.

For example, if you have alert emails going to your cellphone's inbox, you may only want to have the
Target Name, First instance of Failure and Last Instance of Failure in the email. If you have any more
text than that, it will be too long, your cellphone will truncate it and the text is pretty much useless to
you. We recognized the fact that a lot of people are using RIM devices, pagers or cellphones to receive
alert email, and so now we have an editor to help you out.

You can customize the email body text to your liking in the left pane's editor, highlighting attributes on
the left and clicking the Insert Selected Item button to enter that attribute into the body text to the left.
This ability to highlight and insert the alert specific attributes is a great way to avoid typographical errors,
and is highly recommended. When you're done with your changes, just click the Save button to save
your new alert email body. If you get to the point where you want to start over again with the original
email, just click the Revert to default email button and then start your changes anew. If you change
your mind about editing the email body at all, just click the Cancel button to go back to the Alert Editor.

A note about "average" response times.

Average response times are a problem.  The real problem with mean averages is when a server stops
responding - what is the average of the last 10 samples if the last 10 were timeouts?  Because of the
problem with this we always do "when X or more samples is > Y" (this is a median average).  You can
still get your alert to work like an average - by saying "when 5 or 10 samples exceeds 300 ms" (this
would be like a mean average over 300ms, but would also fire when there were lost packets). 
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7.2 Troubleshooting Alerts

If alerts aren't working, there are a number of things you can do to troubleshoot.  Here are some
suggestions - and feel free to check out our support pages for more information.

Make sure you're "Watching" a host with the alert.

By far, the most common reason that an alert isn't working is because it isn't tied to an IP address.  An
alert won't just start working automatically - you need to tell it which host(s) you want that alert to watch.

To attach an alert to an IP, trace to the host you're interested in. Then, right-click on the target you want
to monitor and select "Watch this host (Alerts)..." from the menu.

From here, you can move an alert from the "Available" to the "Selected" list.  Any alerts on the
"Selected" list will watch this host whenever this host is involved in any route (be it an intermediate host,
or the final destination).

When a host is being watched by the alert system, there will be brackets around the hop number in the
upper graph.  If those brackets aren't showing, then that host isn't being watched. This should put a [...]
around the hop that's being monitored.

Set up an alert that will fire instantly, with an event that is very
evident.

If you have an alert set up - and tied to a host (see above), but it seems like the alert isn't working, then
changing your alert parameters (or create a new "test" alert).  

Set up "Traces to Examine:" to 10.  Alert when "1" or more traces are over 1ms.

Unless your network is responding in 1ms or less, this alert will fire on the first collected sample with the
alert enabled.

For an event type, use "Play a sound", or "Tray icon change/notification" as both of these events happen
immediately with no wait.  In addition, for the "Play a sound", use "each time alert conditions are met
(repeating)", as this will continuously make sound, rather than just when conditions start / stop.

Using this sequence, you should be able to tie an alert to just about any host and have the alert
conditions fire immediately.  Now, add on another event type (ie: email).

You can leave multiple events tied to a single alert - that way you can continue to hear the sound while
you're troubleshooting another event type.

7.3 Email Setup (for alerts)

The email setup dialog is used to set up emailing for alerts.  If you're not using alerts, or you're not
interested in having the alert system email you, then setting this up is not required.

Return Address

All outgoing emails will have a return address specified, and this is the address that is used.  Please
make sure you specify a valid address here since this is where all the bounce messages will come
from.  Some ISP SMTP servers only allow emails sent out with a "from" address of their domain as
well, so if you're having problems getting the SMTP server to work, make sure you're using a valid
return address.

Include "alert" samples in text message

If this option is checked, any outgoing alert emails will include text showing the samples that failed the

http://www.pingplotter.com/support.html
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alert.  As each alert email goes out, the past history is marked as being sent already so that you won't
get duplicate data in reoccurring emails.

SMTP Server

The SMTP server is the server that your outgoing mails will go through.  This may have been given to
you by your ISP or your mail administrator.  

Server Port

The default port for most SMTP servers is 25.  If you connect to your SMTP server via a different port,
then enter that port here.  Leaving this blank will use port 25.

SMTP Authentication

Some SMTP servers require a username and password to be able to deliver mail.  If this is the case
with your server, turn on the "Use SMTP Authentication" checkbox, and then enter your username and
password.  The password is saved in your MultiPing.ini file using a basic XOR encryption scheme - this
will keep your password hidden, but this encryption method is relatively simple to "crack" if someone
really wants to figure it out.

Use STARTTLS encryption if server supports it.

Most current SMTP servers prefer or demand the use of a secure channel to protect your username
and password.  If you use one of these servers (GMail is a great example of one), then you'll need to
turn on STARTTLS.  For more details on this topic, see our knowledge base article.

7.4 Alert Events

7.4.1 Event Notification

Many of the events share a notification mechanism.  Here is a list of the types.  Note that any alert can
have multiple events of the same type, so you can set up a single alert to do something at any one or all
of these times.

Each time alert conditions are met (repeating)

The event will happen every time conditions are met.  This means the event will happen over and over
again - on each sample that causes the alert to fire.  In previous versions, this was the only supported
notification type.

When alert conditions start (enters alert state)

The first time alert conditions occur, the event will happen.  As long as the conditions continue, though,
the event won't be repeated.  This is a popular use - as you find out about new conditions when they
happen, but don't have to be bothered again.  As soon as the alert stops happening, then as soon as it
starts again, this event will happen again.

When alert conditions end (leaves alert state)

This happens when network conditions improve so that the alert is no longer firing.  As soon as the
conditions move from bad to good (based on your settings), then this event will happen.  A use of this is
to have MultiPing email you each time conditions go bad (see above), and then when they improve again
- but not to tell you anything in between.

Each time alert conditions are *not* met

http://www.nessoft.com/kb/67
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This is the exact opposite of the first notification type above.  As long as things are good on the network,
this event will fire each time a sample is collected.

7.4.2 Event - Play a Sound

One of the most simple event types is to play a sound (i.e.: .wav file) of some kind.

This event can happen based on the standard notification rules , and can play anything that Windows
multimedia sound function wants to play.  If you want to launch a sound file that this event type doesn't
support, use the "Launch an executable " option instead, as it will launch any file, including sound
files.

Click the folder on the right side of the file name to browse for a file.  When browsing for files, you can
right-click on any sound file to play it (this is an operating system feature, and may not be supported on
all operating systems).

Enter "BEEP" (no quotes) here if you just want to beep the computer speaker instead of playing through
the sound card.

7.4.3 Event - Send Email

A very popular event type is the "Send Email" event.

Before you can create an event to send an email, you must configure your SMTP server and return email
address .  Note that your SMTP server must be accessible on the network to be able to send emails,
so it's possible a network failure may not be able to email you.  MultiPing will continue to try to send
emails once a minute until it is able to get an email out.

Emails are a bit more complicated to set up than most Event types - as it is dependant on your SMTP
server, and you don't want to be overwhelmed with emails when conditions are bad, but you *do* want to
know what's going on.

First off, you can fire emails based on the standard MultiPing notification types.  See the associated
documentation for more details .

Send e-mail to:

This can be an individual email address, or a list of addresses separated by either a , or a ; (both work
equally well).  Please do not set this up to be someone at your ISP unless they have agreed that they
want to see this information.  A huge portion of getting problems solved is playing the game right, and
overwhelming people with automated emails is almost certainly going to work against you.

Email Subject:

This defaults to "MultiPing Auto-Alert!", but can be customized with a variety of variables / text.  Click
here to see this list .

For emails, the $host makes a huge amount of sense (i.e.: $host is down!), while the time/date aren't as
useful because the email already contains data about this in most cases.

Maximum email frequency and minutes to wait  

The next two settings control the frequency at which you'll get e-mails during alert conditions. 

We recommend settings both of these values to 0 (no delay) when using a "When alert conditions start"
and "When alert conditions end" event types.

When using a "Every sample" event type, though, this will result in massive overload of emails, so you'll
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want to limit the number of emails sent.  

The first (Maximum e-mail frequency) means that you'll only get emails that often for this alert/target/
event combination.  Once you get an alert email, you won't get *another* one until this amount of time
has passed. If conditions call for an email to be sent, it's delayed until this amount of time has passed. 
Beware that conditions may have changed between the time the alert is "queued" (and delayed) and the
point where the alert email is sent out (because it's been delayed by this setting).  This can be confusing
(which is why we recommend setting this to 0 on alert conditions start and alert conditions end events).

The second (How long to wait for worse conditions) specifies how long MultiPing will wait after its first
alert condition to send an e-mail. This option allows you to wait a few minutes to find out if it was a
temporary or more permanent alert condition. You may not want one immediately - because you'll want
to wait a bit more info to be included - so you may want to wait 5 minutes or so before that first e-mail
gets sent off. 

Testing and error messages

Once you have your e-mail set up, use the "test" button to see what the
message will look like (and also to make sure all the settings are working).  Any
errors should be displayed here.

Many of the errors that occur during testing can be attributed to incorrect email
setup - so go there and validate your settings .

Here are some specific knowledge base articles on possible error numbers:

Socket error 10053

Socket error 10060

Socket error 11004

Any Socket error is being generated by the SMTP server itself, not MultiPing, so if you're getting an error
number not listed here, or in our knowledge base, try doing a search on your favorite search engine to
see if you can find more information about the error you're getting.

7.4.4 Event - Launch an executable

This event type gives you all kinds of capabilities to do things when network conditions go south.

While this option is called "Launch an executable", it can actually launch any file.  It can launch
documents, links, .mp3s, batch files, whatever - really anything with a file association that Windows will
know what to do with.

Of course, you can control when you want to launch the executable (when the problem starts?  when it
ends?).  See the associated documentation for more details.  

The filename to launch (and/or parameters for that filename) can use variables  to pass an IP Address,
name and date/time to the called program.  Note that these are always parsed - and there is no way to
cause these to be passed as literals.  If you need to have one of these strings as literals passed to an
executable, then you'll need to set up an intermediate link, batch file, or similar.

Note: The launching program isn't closed - it's just launched.  You'll need to configure your setup to do
any appropriate follow-on actions.
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7.4.5 Event - Log to file

The "Log to file" alert writes data to a text file whenever alert conditions are met.

Log times for entire route?

This option specifies if you want to write data to the text file just for the monitored host, or the entire
route.  Leaving this off means that for each time alert conditions are met, one data item will be written to
the file - for the monitored host.  If the switch is turned on, then data for the entire route will be written.

Filename:

The filename is *required* to have the $host variable in it (or some variable that changes depending on
which host / target is being logged ).  If it is missing, then the file will be nonsensical if you attach this
alert to more than one host.  The following variables can be used as part of the filename.  Note there is
no way to "escape" the following sequences, so these are always parsed and can't be specified as
literals in the filename.

$host Host name (or IP address, if no name exists).  

$hostip The host IP address

$hostdnsname The resolved DNS name for the host

$year Current Year

$month Current Month

$day Current day of month

$hour Current hour

$minute Current minute

$second Current second

$date Same as $year-$month-$day.

$time The same as $hour$minute - note the absence of any punctuation - that's to make
sure the file name is valid, if this mask is being used in a file name.

Note that only one directory level of depth will be created automatically if it doesn't already exist, so you
can specify c:\ping data\$host\filename.txt and the $host directory will be created as needed.  Only one
directory of depth will be created, however, so if the c:\ping data directory didn't already exist, an error
would occur.

7.4.6 Event - Tray Icon Change

This is a great event to add to most of your alerts.  It's helpful to be able to see if there's an alert
condition under way, and a quick glance at the tray can let you know by using the event.

The Tray Icon Change notification will do one or both of the following:

Change default icon to red during alert conditions

If you already have MultiPing showing in the tray, this will change the existing green icon and add red to
indicate that an alert has fired.  If you don't have MultiPing in the tray already, then a red icon will be
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added to the tray.  When the alert condition(s) are over, the icon will change back to green.

Popup message in tray

This shows a "balloon" message coming out of the tray.  Not all versions of Windows support this
message (ie: some versions of Windows 95), in which case no balloon will show.  Only one balloon can
be shown at a time, so the newest balloon always wins (a new balloon message will replace an older
one).

Variable substitution  will be done on your message text.  

One of our favorite messages is:  Alert fired on $host, $date $time. This is a great message because it
stays up until you acknowledge it, so when you come back to a PC, you can see what alert fired, what
host it happened on, and what time it *last* happened.  This may be over a weekend, but the message
will still be there telling you that an alert happened.

7.5 Variable Substitution

A number of the alert parameters allow you to insert a variable which will be substituted for a value when
the alert happens.  Here is a list.

$host Host name (or IP address, if no name exists).  

$hostip The host IP address

$hostdnsname The resolved DNS name for the host

$year Current Year

$month Current Month

$day Current day of month

$hour Current hour

$minute Current minute

$second Current second

$date Same as $year-$month-$day.

$time The same as $hour$minute - note the absence of any punctuation - that's to make
sure the file name is valid, if this mask is being used in a file name.
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